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2 Quark XPress 6.0

Creating an Ad in QuarkXPress 6.0

When creating an ad from Quark 6, go to the
File dropdown menu, and select New Project.

Project...
Open
Close EW
Save 265
Save as... S
Revert to Saved
Get Text/Picture... aEE
Save Text... L 2EE
Append... NCERA
Export [ 3
Save Page as EP5... W 1irdt5
Collect for Ourtput...

Under Layout Type, select the Print option.

The Page Size should be the trim size of the
ad to be printed in the magazine.

If you should wish to edit your trim size after
leaving this window, go to the Layout menu and
select Layout Properties.

New...
Duplicate...
Delete

Layout Properties... .

Prawviniis

In this window, enter the correct width & height
of your ad under Page Size. The width and
height should be the trim size of your ad.

~Page ~ ~Margin Guides ——————,
Size:  [US Letter ) Top: 0"
Width: 85" Bottom: 0"

Height: 1 Left: o"

T
Orientation: Right: 0"

New Project

Layout Name: Layout 1

Height: 1 Left: o"

1"
Orientation: Right: 0"

"l Facing Pages ~Column Guides

[ Automatic Text Box Columns: 1

Gutter Width: | 0.167"

(Cnce) 06

Layout Type: | Print I—H
~—Page - ~—Margin Guides

Size: | US Letter ITH Top: o

Width: 8.5" Bottom: 0"

Editing Colors

To edit, delete, or change colors for your docu-
ment, go to the Edit menu and select Colors.

Can't Undo aE7
Can't Redo {r3EZ
Cut 3EX
Copy #C
Faste 2V
FPaste In place T ir3EV
Clear

Select All A
Show Clipboard
Find/Change HF
Style Sheets... 1rF11

Continued »




Next, select the color you want to modify and
click Edit.

Colors for Projectl

show: | All Colors =

ar
i

M Elack

MElue

B Cyan

Mivagenta

MW PANTOME Reflex Blue C
B PAMNTOME Rubine Red C
M Red

W Registration

Separated color; Cyan: 0%; Magenta: 0%; Vellow: 100%; Black: 0%

LA

Mew  Edit | Duplicate ) Delete
(nppend...;l (EditTrap) ( Cancel ) [ Save

)

In this example, we selected Reflex Blue and
wish to change it to CMYK.

Edit Color

Name:
| PANTONE Reflex Blue C e llow Furple

Process Yellow

ellow 012 Yiolet Process Magenta

Model: | PANTONE® solid coa... | :]

Orange 021

Elue 072

Process Cyan

ESpot Color

Halftone: | Process Black I-C}

o arm Red Process Black

Red 032 Process Blue

Rubine Red Green
Rhodamine Red Elack
New: 8 e
Original: PANTONE 5
(Cancel)
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To do this, click on the Model menu dropdown
and select CMYK.

Name: Multi-Ink
e
PAMTO DIC | Purple Process el
= FOCOLTONE

Model: | v PANTONE® solid coated [Violet Process Mag
PANTONE® solid matte e ; -

@ spot|  PANTONE® solid uncoated = e
PANTONE® pastel coated

Halftong  panrAnEs nacral inenarad

Then deselect the Spot Color box.

Edit Color

Name:
| PAMT ONE Reflex Blue C

Model: | CMYK )

[ Spot Color

Halftone: Process Black

C: 100% '—6
New: M: 73% ‘_'@'—

Y (0% | B——
Original:

K: 2% 6—

The color will now print as 4-color process rather
than a spot color.

Continued »
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Checking Fonts and Images

To see the fonts and images being used in the
document, select the Utilities menu and scroll
down to Usage.

Utilities

Check Spelling »
Auxiliary Dictionary...

Edit Auxiliary...

Suggested Hyphenation... “{r3H

Hyphenation Exceptions...

SUsge |

XTensions Manager...
Component Status...

To check the document fonts:

In the Usage window, select the Fonts tab to
view the font usage. In this example, all the fonts
are properly loaded.

Usage for Layout 1

{-Funtr | Pictures | OPl = Placeholders -

MName

Frutiger 56 Italic «Plains

Futura CondensedBold «Plaine
Futura Light «Plain»

Helvetica «Plain»

Helvetica CondensedBlack «Plains
TimesNewRomanPs «Plains
TimesNewRomanPs Balditalic «Plain»
Zapf Dingbats «Plain»

In the window below, some fonts are missing,
which is indicated by brackets around those
fonts. In this example, TimesNewRomanP$ and
TimesNewRomanPS$ BoldItalic are missing.

Usage for Layout 1

{"Foms | Pictures = OPl | Placeholders |

Name N

Frutiger 56 Italic «Plain»

Futura CondensedBold «Plain»

Futura Light «Plains

Helvetica «Plain»

Helvetica CondensedBlack «Plains

Zapf Dingbats «Plain»

{-7, TimesMewRomanPS} «Plain:

{-8 TimesMewRomanPSs Boldltalic} «Plains

Any missing fonts will need to be loaded into
and activated in your Font Manager.

Please be sure to use only Type 1 fonts.
TrueType, Multiple Master and Composite fonts
will not be accepted.

To check the document images:

The next tab is the Pictures window. The only
types of images that should be used are EPS,
PDF, TIFF, and CT. File types that should not
be used are jpeg, gif, native photoshop, pict, and
DCS.

Usage for Layout 1

| Fonts | Pictures | OPI  Placeholders |

Frint Name i Page Type Status
=] CAK-40124: . :Desktopiimage3.sct 1 T OK
] DAK-40124:  Deskionimage tif 1 TIFF 0K
-] OAK-40124: . :Desktopiimagel.eps 1 EPS Missing

I Mare Information

( Done ) Show Update..

The status of each image should read OK|
indicating that the image used in the document
1S not missing.

If the status says Missing, click on the image
name and select Update. This will open a win-
dow that will allow you to locate the image and
update its status. Once updated, the status
should now be OK.

Usage for Layout 1

| Fonts | Pictures | OPI | Placeholders |

Print Name Page Type Status
-] OAK-40124:  :Desktopcimange3 sct 1 T 0K
-] DAK-40124:  Desktopimage2 tif 1 TIFF OK
-] QAK-40124: :Desktopiimagel eps 1 EPS OK

1 Mare Information

Done Show Update...

In this window you should also be sure that all
images are checked in the Print column. Any
image that does not have a checkmark here will
not print when output.

Continued »



Under the OPI tab, the OPI box should not be
checked when creating local postscript files to

your desktop.

Usage for Layout 1
! Fonts | Pictures | OPI| Placeholders |
OPI Name Page Type Status
o OAK-40124:. :Desktop:image3.sct 1 cT 0K
(] QAR-40124.  DeskiopimageZ tif 1 TIFF OK
o OAK-40124:. . :Desktopimagel eps 1 EPS OK
[ More Information SHow Update...

If you must use OPI, please contact your IT pro-
fessional for instruction.

When all settings have been checked, click Done
to close the window.

Note: When OPI is selected, lo-res images will be
swapped or exchanged out with a hi-res
version of the same image. When sending
native or PDF files this can cause images to
print lo-res or not at all, due to the differvent
platforms (Unix, Windows, etc.) to which the
files are goinyg.

Quark XPress 6.0 5
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Creating Postscript from
QuarkXPress 6.0

Distiller Settings and Printer Drivers

It is important that you download the Acrobat
Distiller settings and appropriate PPD (postscript
printer driver) before proceeding.

To install the PPD on a PC, copy the PPD into
the System32 directory of the windows directory
specific to the system you are running.

Once installed, restart your computer.

To install the PPD on Mac OS X, copy the PPD
into the Printer Descriptions folder located on
your Hard Drive at Library > Printers > PPDs >
Contents > Resources > en.lproj.

Once installed, restart your computer.

In Quark, double check to make sure your PPD
is installed and selected. To do this, select PPD
Manager under the Utilities menu.

Check Spelling [
Auxiliary Dictionary...
Edit Auxiliary...

Suggested Hyphenation... “C{r3H

Hyphenation Exceptions...
Usage...

XTensions Manager...
Component Status...

PPD Manager...

Check Out License...

Scroll through the list and check Prinergy
Refiner.

PPD Manager

| Include Name ) o |
-] NeXT 400 dpi Laser Printer
o Prinergy Refiner

o QMS ColorScript 100 Model 10

o QM3-PS 1700 m

o QM3-PS 2000

o QM3-PS 2200 %
~Location:

Macintosh HD:System Folder:Extensions:Printer Descriptions:Prinergy Refiner

.—E Use Auxiliary Folder

(. Update) ( Cancel) G—BH

Continued »



Creating Postscript

Quark XPress 6.0 7

Select the next tab to go into the Setup screen.

To save a postscript

file out of Quark, go to the

File menu then down to Print.

New >
Open [
Close EW
Save 35
Save as... IS
Revert to Saved

Get Text/Picture... aEE
Save Text. CHE
Append... N3EA
Export [ 4
Save Page as EPS... C{r3ES
Collect for Qutput...

Page Setup... N3P

The first tab is the Layout screen. All boxes

should be unchecked. Set Page Sequence on All

and Registration to Center.

// Print Layout 1
Print Style: | Default /I )
Copies: [T | / Pages: W @
{ Lavnut(!——ﬁlup'-() Output | Options  Llayers Bleed = OPl | Preview
Printer Description: Prinergy Refiner )"e"!
Paper Size: " Custom s
Paper Width: 957 Paper Offser: 0"
Paper Height: Automatic E} Page Gap: 0"

Reduce or Enlarge: 100% | Fit in Print Area

Page Positioning: Center Horizontal @ Orientation:

(Capture Senings) C Cancel ) G—met—;

(Page Setup...) ( Printer... ) |

Print Layout 1

Print Style: Default f '3'!

Select Prinergy Refiner as the PPD (Printer
Description).

Select Custom from the Paper Size pulldown
menu and type in the trim size. The paper width
and height should be the Ad Document size plus
one inch. The example is for an 8-1/2 x 11 page
with 1 additional inch.

Always print at 100% and set Page Positioning to
Center. No rotation should be used, the docu-
ment should be set to the correct Orientation.

Print Layout 1

Copies: |1 Pages: All

*{Lavm | Setup  Output

Options  Layers Bleed | OPI Preview

[_|Separations

I Print Blank Pages

Page Sequence: ' All b

Registration: | Center... |

"] Spreads __ Collate

] Thumbnails " Back to Front

Offset: 12 pt

Print Style: | Default

)

Copies: |1

Pages:  All @

! Layout Setup | Output | Options = Layers | Bleed OPl | Preview

Tiling: Off H] Overlap:

__ Absolute Overlap

(Capture Semngs) ( Cancel ) E—Pnnt%

(Page Setup...) C Printer... ) |

Tiling should be set to Off and the Offset should

be set at 12 points. (Offset refers to the spacing

between the page trim size and where the rvegistra-
tion marks begin. 12 points will give you approxi-

mately 1/8 inch offset.)

If you are working on an oversized or tabloid
publication (8-3/8” x 10-7/8” or larger), the
oftsets should be set to 3/16” instead of 1 /8.

Print Colors: ' Compesite CMYK s Resolution: | 2400 % (dpi)
Halftoning: | Conventional @ Frequency: | 133 @ (Ipi)
¥ Print Plate | % Halftone | % Frequency % Angle + Function |
=] Process Cyan - 133 105" Default
- Process Magenta - 133 75" Default
o Process Yellow - 133 ¢ Default
L] Process Black - 133 45" Default

(" Capture Settings ) ( Cancel ) { Print )

CPage Setup_..) ( Printer... ) ‘

Under the Output tab, set Print Colors to
Composite CMYK for 4-color printing. And set
Halftoning to Conventional.

Continued »



8 Quark XPress 6.0

Continuing under the Output tab, (see example
on the previous page) a resolution of 2400 dpi and
frequency of 133 Ipi will work with most, if not
all, of the printer RIDPs.

In the bottom of the Output window only the
four channels (CMYK) should be present. If
there are more, delete the extra colors in Quark
or set them to convert to process.

Print Layout 1

Print Style: | Default 4]

Copies: 1 ] Pages:  All

layout | Setp | Outpur | Options | Layers | Bleed | OPl | Preview |

"1 Quark PostScript Error Handler

Page Flip: None [#1 [ Megative Print
—Pictures
Output: | Normal [21 _ Full Res of Rotated Objects
Data: Binary '+1 ] Overprint EPS Black
OPl: Include Images = gFuII Resolution TIFF Output
(Pags 5EIU;}...> (_ Printer... ) | CCapturE Settings) ( Cancel ) ( Print )

Under the Options tab, the Output for Pictures
needs to be set to Normal. If this is not done,
you will receive lo-res images in your postscript.
Note: the only object that should be checked is Full
Resolution TIFF output.

Data should be set to Binary and OPI to Include
Images.

Print Layout 1

Print Style: | Default 4]

Copies: 1 l Pages: All @

Layout | Setup  Output = Options | Layers | Bleed = OPl  Preview )

% Print o, MName
L] Default

] Apply to Layout
Plates used on selected Layer:
Mo selection

(Page Setup...) (_ Printer... ) | CCapmrE Senings) ( Cancel ) ( Print )

When sending or creating postscript, layers can
cause problems in output. All layers intending to
print should be checked.

Depending on the magazine specifications, bleeds
may vary. This is an example of a standard 1/8”
bleed, which is used for all trim sizes smaller than
8-3/8” x 10-7/8”. Anything at that size and larg-
er should be set up with 3,/16” bleed margin.

Clipping at bleed is for any object hanging outside
the bleed area.

Print Layout 1

Print Style: | Default r+
Copies: 1| Pages: AH—
Layout | Setup = OQutput | Options = Layers | Bleed | OPI Preview
Bleed Type: Symmetric /%1 Amount: 0,125"
Eclip at Bleed Edge Bottom: 0"
Left:
Right:

OPI should not be used when saving postscript
locally to your hard drive. If your business uses

OPI please contact your IT department for help
on saving postscript without OPI.

Print Layout 1

Print Style: | Default )

Copies: E Pages:  All @

Layout Setup Output Options Layers Bleed | OPI | Preview -

1 0PI Active
“TIFF — - —EPS
__Include Images _Include Images
_ Low Resolution

The Preview window is a quick overview of the
options you selected. To go to the next step,
click the Printer button.

Print Layout 1

Print Style: [ Default o+

Copies: 1 ] Pages:  All @

Layout | Setup = Output | Options | Layers | Bleed = OPl | Przvim!—

Imageable Area Composite: CMYK  —
W 95" Tiles: 1
H: 12" Scale: 100%
eyt size Paper Offfget: U. .
Wes s Page Gap: o = +§ R +
H. ?1‘2 Rotation: 1] =
} Registration: Centered
Bleed: Symmetric Align: Center
Amount: 0.125" ive:
oLy Nega_tlve. No e
Reading: Right
Hip: None @
(Page Serup...) (_ Printer... ) ‘ (Caprure Semngs) ( Cancel ) ( Print )

Continued »
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The Printer pulldown menu should be set to a Navigate to the desired location to store the
Local Network Postscript printer. If you are postscript file, enter a filename in the Save As
sending multiple pages you must process one area, and click Save.
page at a time or use third party sF)ftware to sep- N
arate out multiple page PDFs to single pages.
The only exception to this rule is for spread s =
pages. These pages can be sent as one PDF file. (<7-) (@ @EDeskwop B
' Name 4 Date Modified
Brint @ Newwork [Z fonts 3/30/04
é DAK-40124 imagel.eps Today
printer: | Adobe PDF |—¢] ﬁ Fiiitie image2 tif Today
i - 8 image3.sct Today
Presets: | Standard I’#i ‘ ;Z\-’D“tl .
e — i oAy L Imark.par
R }d ’j.} mkanalas il % PitStop Professional Setup (US) 3/25/04
Eonies: 1— [ Collated Ahpphcaﬁons | test file 3/30/04
Pages: () All TE‘ Documents
@ From: 1 to: |1 u‘* —
& music
@ (Preview) (SaveAs PDF...) ( Fax... ) (Cancel) G—Prmt—a ﬂ Pictures
C_ Hide extension € save )
Under the Copies & Pages dropdown menu, To create a PDF from your postscript file, drag
scroll to Output Options. Click Save as File and and drop the postscript onto Acrobat Distiller,
select Postscript format. DO NOT SELECT
hek:] JAcrobat Distiller
PDF. Adobe POF Settings
Default Settings. | Creo POF Pages. =)
=  Compatibulity: Acrobat 4 (PDF 1.3)
rint B
Printer: | Adobe PDF =)
Presets: | Standard ] Current File Information
| Output Options }-é-ii :’I: e (Paute )
e o)
ESave as File Format | PostScript H"]
Progress
Status; Ready =214
@ Preview (SaveAsPDF...) ( Fax... ) (Cancel) (—»ﬁmom—)
g‘lﬂ’:"'h"l?w":ﬂ”ﬂ":}“s:»ﬂ@ 15, 2004 a1 1253 PM

Source: sarsimac 1 DEKopLayoul 1 53
Destination; Asersmact DeskiopLayout 1.pdl

Agobe POF Senngs: Usery/Shared/Asobe POF 6.0/5emnguCreo PDF Pages jobopbions
%] Waming: Empty job. Ne POF file produced. | %%

gl Time: D e4£onas (00 0000}

~** End ol Job "

e =——1

In the third pulldown menu select Printer
Features. The Resolution should be 2400dpi.
When all settings are correct, click Save.

Print
printer: [ Adobe PDF ]
Presets: | Standard ]
| Printer Features }'%'!
Resolution: | 2400dpi )
@ Preview (SaveAs PDF...) ( Fax... ) ( Cancel ) Gm;




